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This guide describes the installation and use of the webMethodsMicrosoft Package. This package
facilitates use of theMicrosoft .NET application platform in conjunctionwithwebMethods products.
You can administer and manage the webMethods Microsoft Package from any standard browser.
Using thewebMethods forMicrosoft Plug-in, you can create services fromexisting .NET assemblies.
Using thewebMethodsAdd-In forMicrosoft Visual Studio, you can browse services on Integration
Server and generate the code to invoke those services.

To use this guide effectively, you must:

Understand the basic concepts of Microsoft .NET and Microsoft .NET Framework.

Be familiar with the setup and operation of the webMethods Integration Server.

Have a general idea about how to perform tasks with Software AG Designer.

Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...
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Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://
documentation.softwareag.com.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.comwith
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

You can find product information on the Software AG Empower Product Support website at
https://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give us
a call.

Software AG TECHcommunity

You can finddocumentation and other technical information on the SoftwareAGTECHcommunity
website at http://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

Link to external websites that discuss open standards and web technology.

Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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What is webMethods Microsoft Package?

The webMethods Microsoft Package provides .NET integration and management services within
webMethods products in a tightly coupled implementation. The webMethods Microsoft Package
is an umbrella of solutions that encompasses several functional areas. webMethods Microsoft
Package enables you to do the following:

Expose .NET assemblies as integration services

The webMethodsMicrosoft Package exposes, as integration services, the services provided by
.NET assemblies operating in a service provider role. Those integration services can be exposed
to the outside world as Web services just like any other webMethods service. This feature
simplifies integration of business logic developed on the Microsoft .NET platform into
applications external to theMicrosoft environment. Additionally, it simplifies the development
of integration logic using a .NET language of choice.

Allow .NET assemblies to invoke integration services

Microsoft .NET assemblies operating in a client role can invoke services exposed by Integration
Server. The webMethods Microsoft Package provides a native .NET API to Integration Server
for this purpose. TheAPI simplifies the integration of legacy or newbusiness logic intoMicrosoft
.NET applications.

Host .NET executable assemblies

The webMethods Microsoft Package provides hosting of .NET executable assemblies or
applications that may be operating in an Integration Server client role or in a role unrelated
to Integration Server.

Manage .NET assembly lifetimes

The webMethods Microsoft Package provides management of .NET assembly lifetimes for
assemblies operating in a service provider role where multiple invocations of one or more
methods on a given assembly instance is required.

Manage the .NET environment

The webMethods Microsoft Package allows you to manage the .NET environment and view
metrics pertaining to its operation and the operation of assemblies executing in the .NET
environment.

Generate code in Microsoft Visual Studio to invoke services

ThewebMethodsAdd-In forMicrosoft Visual Studio provides the ability to enumerate services
on Integration Server and generate code within Visual Studio to invoke those services.
Installation of the add-in is separate from the rest of the webMethods Microsoft Package. For
information on installing the add-in, see “Installing the webMethods Add-In for Microsoft
Visual Studio ” on page 18.

Integrate with existing COM objects

10 webMethods Package for Microsoft .NET Installation and User’s Guide 9.0

1 Understanding webMethods Microsoft Package



The Primary Interop Assemblies generated by TLBIMP are .NET assemblies and can therefore
be exposed as integration services just like any other .NET assembly. Once exposed as
integration services, they can also be exposed to the outside world asWeb services if required.

Assemblies and their Roles

Components designed to operate within the .NET environment are referred to as assemblies.
Assemblies are of two types, DLLs (dynamically-linked library) and executables. The primary
difference betweenDLLs and executables in the .NET environment, and the equivalent components
in previous versions ofWindows, is that the .NET components require theCLR to execute.Microsoft
.NET assemblies, like components of other programming models, generally operate in one of two
roles: a service provider or a service consumer.

Service providers provide services to external components using the publicmethods and properties
they expose. Service providers are generally (though not necessarily) DLLs.

Microsoft .NET assemblies operating in a service-provider role

Service consumers consume the services provided by service provider components. Service
consumers are generally (though not necessarily) executables.

Microsoft .NET assemblies operating in a client role

Application Domains

An application domain is a boundary between objects in the same application scope, which is
established by the CLR. Application domains provide the ability to isolate multiple applications
running within a process. You can have multiple application domains loaded onto the CLR and
destroy each of them independently without stopping and restarting Integration Server.
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For information on managing application domains in Integration Server, see “The Manage
Application Domains Page” on page 49.

ThewebMethodsMicrosoft Package useswmSystem as the primary domain internally to facilitate
the infrastructure. For running any DLL, webMethods Microsoft Package provides a default
application domain with the domain name webmDomain. When you run a DLL in any application
domain, it becomes locked, meaning that you cannot rename, modify, or delete it at the file system
level. If theDLL is in the defaultwebmDomain, you have to stop and restart the CLR from Integration
Server Administrator to unlock it. By creating a separate application domain running a .NET
service in it, you can unlock the DLL by destroying the application domain rather than stopping
the CLR.

When you create a .NET service from a DLL using Designer, Designer creates a domain named
IntrospectionDomain to introspect this DLL. This implies that the DLL is referenced by the
IntrospectionDomain. Now, when you run this created .NET service by giving a custom application
domain name, this DLL is also referenced by the custom application domain. To rename, modify,
or delete this DLL, you must first destroy the custom application domain, and then also destroy
the IntrospectionDomain. If you had not specified a custom application domain to invoke this DLL,
DLL is invoked under the default application domain named webmDomain, and you must restart
the CLR to modify this DLL.

Using webMethods Products with .NET

The Integration Server provides an execution container for the .NET assemblies. After the CLR is
loaded, the DotNetHost assumes control over it, providing access to the .NET environment from
Integration Server.

Software AG Designer and .NET
With the webMethods for Microsoft Plug-in installed, you can use Designer to generate services
from an existing .NET assembly. This process is referred to as introspection. Designer provides
the ability to locate assemblies by browsing the Integration Server directory accessible from the
Integration Server and Windows services. When you select an assembly, all public constructors,
methods, properties and fields of public classes in that assembly are presented. You can select
which services provided by the assembly are exposed as integration services, and subsequently
as Web services if required.

After the services of assemblies are exposed as integration services, you can invoke them as you
would any other integration service.

Integration Server Administrator and .NET
Through the webMethods Microsoft Package, you can use Integration Server Administrator to
view application domain statistics, load assemblies, start and stop the .NET environment, and set
diagnostic tracing. As service invocations occur, the package collects metrics for execution times
and invocation counts on a method and assembly instance basis. You can retrieve these metrics
using Integration Server Administrator.

See “Administering the .NET Package” on page 43 for more information.
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webMethods Client API for .NET
The webMethods Client API for .NET provides access to Integration Server and its services from
the .NET environment. The API hosted within a CLR can be accessed by client assemblies that are
within the same CLR, or within a remote CLR. The code required to invoke integration services
using the .NETAPI can be createdmanually, generated byDesigner, or by thewebMethodsAdd-In
for Microsoft Visual Studio.

webMethods and Visual Studio
ThewebMethodsAdd-In forMicrosoft Visual Studio permits you to connect to a given Integration
Server and list the packages, folders and services configured on the server. After a service is
selected, you can use webMethods Add-In for Microsoft Visual Studio to generate the C# or VB
code required to invoke that service. The Visual Studio user is not required to know what the
target service type is. The target service could be any type of integration service.

See “Using thewebMethodsAdd-In forMicrosoft Visual Studio ” on page 37 formore information.

Getting Started

The followingprocedures outline the basic steps to get startedwithwebMethodsMicrosoft Package.

1. Install webMethods Microsoft Package. For more information about this step, see “Installing
the webMethods Microsoft Package ” on page 15.

2. Configure basic settings forwebMethodsMicrosoft Package. After completing the installation,
set the required configuration properties. For details, see “ConfiguringwebMethodsMicrosoft
Package ” on page 23.

3. To use DesignerwithwebMethodsMicrosoft Package, import the required .NETmethods into
Software AG Designer. For more information about this step, see “Using Designer with the
webMethods Microsoft Package ” on page 27.

4. To use Microsoft Visual Studio to invoke integration services with webMethods Microsoft
Package, see “Using the webMethods Add-In for Microsoft Visual Studio ” on page 37.
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Overview

This chapter explains how to install, upgrade, and uninstall webMethods Microsoft Package 9.0.
The instructions use the Software AG Installer and the Software AG Uninstaller wizards. For
complete information about the wizards or other installation methods, or to install other
webMethods products, see the Installing webMethods Products On Premises for your release.

The webMethods Microsoft Package contains three elements that can be installed individually.
Install each one on the same host as the product with which they interact:

Needs to be installed with...This element...

Integration ServerwebMethods Microsoft Package

Integration ServerwebMethods forMicrosoftCodeGenerator
Package

Note:
The Integration Server forMicrosoft CodeGenerator
Package is called by Designer and by the
webMethods Add-In for Microsoft Visual Studio to
generate code, but does not require a Windows
environment to run.

Microsoft Visual StudiowebMethods Add-In for Microsoft Visual
Studio

You cannot use Software AG Installer to install the webMethods Add-In for Microsoft Visual
Studio. Youmust install this element separately, as described in “Installing the webMethods Add-
In for Microsoft Visual Studio ” on page 18.

Supported Platforms, Operating Systems, and Microsoft
Products

For a list of the operating systems, webMethods products, and required Microsoft products
supported by thewebMethodsMicrosoft Package, see thewebMethods Adapters SystemRequirements
, available in the webMethods area of the Software AG Documentation Web site.

Installing the webMethods Microsoft Package

Important:
This section provides only instructions that are specific to installing the webMethodsMicrosoft
Package and thewebMethods forMicrosoft CodeGenerator Package. For complete instructions
on using the Software AG Installer, see the Installing webMethods Products On Premises for your
release.

Installation for the webMethods Microsoft Package and the webMethods for Microsoft Code
Generator Package is similar. Install each element on the appropriate computer:
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On the same computer as...Install this element...

Integration ServerwebMethods Microsoft Package

Integration ServerwebMethods for Microsoft Code Generator
Package

Important:Software AG recommends that you use only one instance of Integration Server with
webMethods Microsoft Package installed on the Integration Server on a system. However, if
you need to use webMethods Microsoft Package with multiple instances of Integration Servers
on the same system, see “Using webMethods Microsoft Package with multiple instances of
Integration Server ” on page 21.

To install elements of the webMethods Microsoft Package

1. Shut down all webMethods products.

2. Download Installer from the Empower Product Support Web site.

3. Start the Installer wizard.

Choose the webMethods release that includes the Integration Server on which to install
the package. For example, if you want to install the package on Integration Server 8.2,
choose the 8.2 release.

If you are installing on an existing Integration Server, specify the webMethods installation
directory that contains the host Integration Server. If you are installing both the host
Integration Server and the package, specify the installation directory to use. The Installer
will install the package in the Integration Server_directory \packages directory.

4. In the product selection list, selectAdapters > webMethods Microsoft Package. The following
elements are automatically selected and will be installed:

Note:
You can deselect any of the individual components and install only the ones that you need.

Program Files 9.0 This component will install the webMethods Microsoft Package
(WmDotNet) containing services that you use to create andmanage aMicrosoft .NETCLR.

Code Generator 9.0 This component will install the webMethods for Microsoft Code
Generator Package (WmMSCodeGen) containing services that generate .NET source code.

5. To install documentation for the webMethods Microsoft Package and its components, select
Documentation > Adapters Readmes and Documentation. Note that this will install the
documentation for all adapters.

Alternatively, you can download the documentation at a later time from the Software AG
Documentation Web site.
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6. Enter the HTTP port to be used by webMethods Microsoft Package.

Note:
If the DotNetHost service already exists on the machine, you will not be asked to enter the
HTTP port. Further installations of webMethods Microsoft Package will use the existing
DotNetHost service.

7. After Installer completes the installation, close Installer.

8. Start the host Integration Server.

Note:
Software AG recommends that you install the latest fix to include updates from previous
fixes for this adapter.

Installing the webMethods Add-In for Microsoft Visual Studio

Install the webMethods Add-In for Microsoft Visual Studio on the same machine as Microsoft
Visual Studio.

To install webMethods Add-In for Microsoft Visual Studio

1. Shut down Microsoft Visual Studio.

2. Use the Install VS Plugin page in Integration Server Administrator, as described in “The Install
VS Plugin Page” on page 53, to access the webMethods Add-In Setup.msi files.

You can also download the files from the Empower Product Support Web site.

3. Run the executable file.

Upgrading to webMethods Microsoft Package 9.0

You can upgrade to webMethodsMicrosoft Package 9.0 fromwebMethodsMicrosoft Package 7.1.

To upgrade from webMethods Microsoft Package 7.1 to webMethods Microsoft Package 9.0

1. Back up the entirewebMethods installation directorywhere thewebMethodsMicrosoft Package
7.1 is installed.

2. Uninstall the webMethods Microsoft Package 7.1 using the Software AG Uninstaller, using
the instructions in the webMethods Microsoft Package 7.1 Installation and User’s Guide.

3. Install the webMethods Microsoft Package 9.0 using the instructions in “Installing the
webMethods Microsoft Package ” on page 16.
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4. After installing webMethods Microsoft Package 9.0, if you want to migrate your custom
packages created in webMethods Microsoft Package 7.1, use the
pub.dotnet.migration:upgradeDotNetServices service as explained in the below section
“Migrating Custom Packages” on page 19.

Migrating Custom Packages
You can migrate the custom packages created in webMethods Microsoft Package 7.1 to use these
custom packages in webMethods Microsoft Package 9.0.

To migrate custom packages created in webMethods Microsoft Package 7.1 to webMethods
Microsoft Package 9.0

1. Shut down the host Integration Server.

2. Set the dependency on the custom packages you want to migrate by editing the manifest.v3
file. The manifest.v3 file is located in the same folder as your custom package.

Go to the folder of each custom package that you want to migrate, and edit the requires tag in
the manifest.v3 file, as shown below:

3. Tomigrate the serviceswith assembly path set asMappedDrives or SharedUNCPaths, follow
the directions below:

If your custom package consists of .NET services that refer to Mapped Drives as their
assembly path, move those DLLs to local system drives, and update the Assembly Path
property from Designer.

If your custom package consists of .NET services that refer to Shared UNC Path as their
assembly path, run the windows service named webMethods Package for Microsoft .NET
with Administrator user account (who has privileges to access the shared paths) and then
migrate the .NET services.

4. Start the host Integration Server and verify that the dependency has been set correctly by doing
the following:

a. Go to Integration Server Administrator, and select Packages > Management.

b. Select your custom package from the Package List.

c. Verify that the value for Packages on which this package depends is WmDotNet;9.0.

5. Start Designer and run the service pub.dotnet.migration:upgradeDotNetServices.

Verify that the service output is as follows:

6. Open wmSystem.exe.config file from Software AG_directory /DotNetHost folder.
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Verify that the value of the WhitelistDirectories element is updated correctly. For information on
white-listed directories, see “Specifying white-listed directories” on page 24.

The migrated custom packages can now be used with webMethods Microsoft Package 9.0.

Uninstalling the webMethods Microsoft Package

To uninstall elements of the webMethods Microsoft Package

1. Shut down the webMethods products associated with the element:

Shut down this product...For this element...

Integration ServerwebMethods Microsoft Package

Integration ServerwebMethods for Microsoft Code Generator
Package

2. Start Software AG Uninstaller, selecting the webMethods installation directory that contains
the host Integration Server. In the product selection list, select Adapters > webMethods
Microsoft Package.

3. After Uninstaller completes, restart the host Integration Server.

Uninstaller removes all webMethods Microsoft Package-related files that were installed into
the Integration Server_directory \packages\WmDotNet directory or the WmMSCodegen
directory.

4. Uninstaller does not delete files created after you installed the product (for example, user-created
or configuration files), nor does it delete the directory structure that contains the files. If you
do not want to save the files, do one or both of the following:

And delete the directory...Go to...

WmDotNetIntegration Server_directory \packages

WmMSCodegenIntegration Server_directory \packages

Uninstalling the webMethods Add-In for Microsoft Visual Studio

Perform the following procedure to uninstall thewebMethodsAdd-In forMicrosoft Visual Studio.

To uninstall the webMethods Add-In for Microsoft Visual Studio

1. Shut down Microsoft Visual Studio.
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2. In Windows Control Panel, click Add or Remove Programs to start Uninstaller.

3. Select webMethods Add-In for Microsoft Visual Studio as the program to uninstall.

Uninstaller removes allwebMethodsAdd-In forMicrosoft Visual Studio files thatwere installed.

Using webMethods Microsoft Package with multiple instances
of Integration Server

Important:Software AG recommends that you use only one instance of Integration Server with
webMethods Microsoft Package installed on the Integration Server on a system.

The webMethods Microsoft Package uses the DotNetHost Windows Service with the HTTP port
associated with the webMethods Microsoft Package. There can be only one instance of the
DotNetHost windows service on a system.

If multiple instances of Integration Servers with webMethodsMicrosoft Package installed on each
of the Integration Server are on the same system, all the instances of the webMethods Microsoft
Package will use the same DotNetHost windows service with the same HTTP port number.

The DotNetHost windows service is primarily associated with the instance of the webMethods
Microsoft Package along with which, the DotNetHost service was installed. Hence, any changes
to this instance of the webMethodsMicrosoft Package can cause errors in the remaining instances.

For example, consider the following scenarios:

Scenario 1

webMethods Microsoft Package, say MIP A, is installed on an Integration Server, say
Server_1. As this is the first instance of webMethods Microsoft Package installed on the
system, the DotNetHost windows service is installed and associated primarily with MIP
A. 50000 is set as HTTP Port for MIP A.

Next, another instance of Integration Server, say Server_2 is installed on the same system,
and webMethods Microsoft Package, say MIP B is installed on the Server_2. As these
instances are on the same system, the same HTTP Port is used by both MIP A and MIP B.

If you modify the HTTP port for MIP A to 60000, MIP B fails, as MIP B cannot connect to
DotNetHost windows service on HTTP Port 50000.

As a resolution, you must modify the HTTP Port for MIP B also and set it as 60000. For
information on modifying the HTTP Port, see “Modifying HTTP port” on page 25.

Scenario 2

webMethods Microsoft Package, say MIP A, is installed on an Integration Server, say
Server_1. As this is the first instance of webMethods Microsoft Package installed on the
system, the DotNetHost windows service is installed and associated primarily with MIP
A. 50000 is set as HTTP Port for MIP A.
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Next, another instance of Integration Server, say Server_2 is installed on the same system,
and webMethods Microsoft Package, say MIP B is installed on the Server_2. As these
instances are on the same system, the same HTTP Port is used by both MIP A and MIP B.

If you uninstall MIP A, the DotNetHost windows service is also uninstalled, as the
DotNetHost windows service was installed along MIP A. Now MIP B cannot connect to
DotNetHost windows service on HTTP Port 50000.

As a resolution, youmustmanually install theDotNetHostwindows service, and associate
with MIP B. For information on manually installing DotNetHost windows service, see
“Manually installing DotNetHost as Windows Service” on page 25.
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Overview

This chapter explains how to configure/modify some basic settings for the webMethodsMicrosoft
Package. These basic settings are configured by modifying the wmSystem.exe.config file, part of
the Software AG_directory /DotNetHost folder. Software AG recommends that you must modify
only the properties mentioned in the below sections. Youmust not modify any of the other options
in the wmSystem.exe.config file.

Specifying white-listed directories

To use Designer and create services to invoke .NET methods, the required .NET methods must
be imported to Designer. Before importing the required .NET methods, you must specify the
directories that Designer is allowed to access.

By default, C:\ is the configured white-listed directory. You can specify multiple directories as
white-listed directories. You can also specify a UNC Path as part of the white-listed directories.

To useUNCPath, thewebMethodsMicrosoft Package and the specifiedUNCPathmust be running
under the same user-account. Use two slashes (//) or backslashes (\\) to indicate the machine
name and one slash or backslash to indicate the path or shared directory on the machine.

For example, //test1/MyFolder/MyAssemblies provides the UNC path to the MyAssemblies
directory on the machine test1.

Note:
You cannot specify mapped drives as white-listed directories.

SoftwareAG recommends that you addonly a restricted set of directories, aswhite-listeddirectories.

To specify white-listed directories

1. Go to Software AG_directory /DotNetHost folder.

2. Open wmSystem.exe.config file.

3. Modify the parameter value of the WhitelistDirectories element.

You can specify multiple directories, separated by the ; symbol.

4. Restart the webMethods Microsoft Package windows service.

Modifying CLR Version

CLR 2.0 is the default version of CLR specified with the webMethods Microsoft Package. You can
modify it, and use the required version of CLR.

To modify the version of CLR
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1. Go to Software AG_directory /DotNetHost folder.

2. Open wmSystem.exe.config file.

3. Change the CLR version value by commenting the already set value, and un-commenting the
required CLR version in startup section as displayed below:

4. Restart the webMethods Microsoft Package windows service.

Modifying HTTP port

You can modify the HTTP port specified at the time of installation of webMethods Microsoft
Package.

To modify HTTP port

1. Go to Software AG_directory /DotNetHost folder.

2. Open wmSystem.exe.config file.

3. Change the HTTP port by modifying the port number specified in the baseAddress element.

For example, to set the port number as 9842, set the value of baseAddress element as:
http://localhost:9842/msnethost

Note:
You must specify only a port number that is available and not already in use.

4. Go to Integration Server_directory \packages\WmDotNet\config directory.

5. Open properties.cnf file.

6. Modify the value of port.

Note:
If the properties.cnf file does not exist, create the file and add the port=9842

7. Restart the webMethods Microsoft Package windows service.

8. Go to Integration Server Administrator and reload the WmDotNet package.

Manually installing DotNetHost as Windows Service

In some cases, you might have to manually install the DotNetHost as Windows Service. For
example, if the DotNetHost installation was not completed successfully through the Software AG
Installer, you must manually install the DotNetHost as Windows Service.
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To manually install DotNetHost as Windows Service

1. Open the command prompt.

2. At the command line, type the following command to switch over to the resources directory:

cd Integration Server_directory \packages\WmDotNet\resources

3. Type the following command:

msiexec /i MSNETPackageInstaller.msi /l* log_file ALLUSERS=1 TARGETDIR="
Software AG_directory \DotNetHost" MIPPORT=HTTP port

For example, when the log_file is
D:\SoftwareAG\IS90\install\logs\MSNETPackageInstaller.msi_install_log.txt,
Software AG_directory is D:\SoftwareAG\IS90 and the HTTP port is 50000, type the command
as follows:

Note:
The port number specified must be the same port number specified in the in properties.cnf
file in Integration Server_directory \packages\WmDotNet\config directory.

4. The MSNETPackageInstaller.msi installer window opens with the values automatically
specified. Continue with the installation.

The DotNetHost windows service is successfully installed and started.
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Overview

With the webMethods Microsoft Package installed, you can use the webMethods for Microsoft
Plug-in to scan existing .NET assemblies to determinewhatmethods they contain and then import
the methods into Designer. In Designer, you can create services that call those methods. Once a
.NET service exists within Designer, it can become part of a flow, just like any other service.

To take advantage of this feature, you must have the Microsoft .NET Framework, which includes
theCommonLanguageRuntime (CLR) installed on the same computer as the instance of Integration
Server to which Designer is connected. In addition, the location of the .NET assembly must be
known to Integration Server. For example, assume that you have used Designer to create the
service addInt to call the addIntmethod in mathAssembly.dll. When you invoke the addInt service on
Integration Server, the service calls the addInt method through the CLR.

A service calls a .NET method

Using Designer, you can perform the following actions:

Described here...You can do this...

“Importing .NET Methods into Designer ” on page 28.Import .NET assembly
methods into Designer

“Configuring .NET Assembly Information” on page 30.Modify information
about a .NET method
associated with a
service

“Managing Class Lifetimes” on page 32.Manage the way the
CLRmaintains instance
data

Importing .NET Methods into Designer

You can import methods from Microsoft .NET assemblies and use them to create .NET services.
webMethods services can consume these .NET services.

Tip:
From a practical standpoint, it is easiest to import and maintain all .NET services from an
assembly into the same folder.

To create a .NET service from a .NET method using Designer
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1. The .NET Common Language Runtime (CLR) should start automatically, but if it is not yet
loaded, use Integration Server Administrator to start it.

For more information, see “Starting and Stopping the Microsoft .NET CLR” on page 47.

2. From Designer, go to File > New > .NET Service.

3. Select the folder in which the services are to be created and click Next.

4. In the Create a New .NET Service dialog box, locate a .NET assembly on the path where the
CLR can access it.

This dialog box displays the white-listed directories. For more information on white-listed
directories, see “Specifying white-listed directories” on page 24.The only files displayed in
this dialog box are assembly DLLs or EXEs. You can select multiple .NET assemblies for
importing.

5. After you have selected assemblies, click Next.

6. In the Select Specific .NET services dialog box, select the methods you want to import into
Designer. By default, all methods in all selected assemblies are selected. You can select or clear
whole assemblies, whole classes, or individual methods as needed.

7. Click Finish. Designer creates a service for each method and places it in the specified folder.

Note:
For assemblies that are not located in the same windows domain or on the same machine
as the CLR, the CLR may fail to load an assembly and issue a security error if the assembly
was compiled with the unsafe option or if user permissions for the remote directory do not
permit access. To resolve either condition, copy the assembly to themachine where the CLR
resides, set directory permissions appropriately, or configure a trust relationship between
the domains.

You can view the variables for the resulting service in the Input/Output tab of the editor. In addition
to the variables supported by a specific method, there are variables that are part of each .NET
service.

Input Variables
The trace variable allows you to performmethod invocation tracing for a specific service. Formore
information, see “Method Invocation Tracing” on page 48.

The domain namementions the name of the domain fromwhere youwant thismethod to be invoked.

The marshallingType variable identifies the marshalling type to be used for a specific service, as
described in “Marshalling Data” on page 35. To use a reference ID to marshall data, choose refid.
To actually send data in the form of an XML file, choose xml.
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The instanceID variable identifies a particular session for object instances using a Session class
lifetime, as described in “Managing Class Lifetimes” on page 32. On the first invocation, the
instanceID variable should be set to a value zero. If a Session lifetime is configured for an object
instance, on subsequent invocations, you should set the variable to the instance ID returned from
the first invocation of the method.

Output Variables
As mentioned in “Input Variables” on page 29 instanceID is present as an output variable. This
variable identifies the instance of the session object and can be used as input for subsequent
invocations of the object.

A return variable is also present. The return variable contains the value returned by the method
upon completion of its invocation.

Importing COM Objects into Designer

The Microsoft Type Library Importer (TLBIMP) generates a Primary Interop Assembly, which is
a .NET assembly, from a COM object. Once an assembly is generated using TLBIMP, you can
import the methods from that assembly into Designer as you would any .NET assembly.

In broad overview, these are the steps to import COM objects into Designer as services:

1. If you have not already done so, use the regsvr32 command to register the COM object on the
computer where you will make the conversion.

2. Use TLBIMP to generate the assembly, as in this simple example:

3. Use the output file as though it were a .NET assembly and import it intoDesigner, as described
in “Importing .NET Methods into Designer ” on page 28.

Configuring .NET Assembly Information

When you create a service to call a Microsoft .NET method, Integration Server stores information
needed by the .NET CLR to load the method into its processing space. If you change the location
or name of the .NET assembly in which the method resides, you need to use Designer to modify
that information; otherwise, any attempt to call that method from Integration Server will fail.

Information about a particular .NET method resides with the service you have created to call it.
In Designer, you can see this information in the .NET Properties tab for the specified service.

Note:
When you create multiple .NET services from an assembly, as described in “Importing .NET
Methods into Designer ” on page 28, all of those services share information about the assembly.
If you change shared information for one .NET service, it is changed for all.

The Shared Properties panel of the .NET Properties tab consists of information that is common
to all .NET services created from the same assembly:
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DescriptionProperty

The name of the application domain in which the service is to
run. Editable.

Domain Name

The location of the directory that holds the .NET assembly in
which the method called by this service resides. Editable.

Assembly Path

Changing the assembly path of a .NET service applies to all the
.NET services in the assembly.

The name of the .NET assembly in which the method called by
this service resides. Editable. Changing the assembly name of
a .NET service applies to all the .NET services in the assembly.

Assembly Name

The configuration file associatedwith the domain. The filemust
be located in the Assembly Path. Enter only the file name. For

Domain Configuration File

more information about domain configuration file, see
“Managing Domain Configuration File” on page 32

The fully qualified name of the class ofwhich themethod called
by this service is a part. Not editable

Class Name

The lifetime setting assigned to the class that owns the method
called by this service. Editable. For information about valid

Class Lifetime

class lifetime settings, see “Managing Class Lifetimes” on
page 32.

The timeout setting assigned to the class that owns the method
called by this service. Valid only for a Session lifetime. Editable.
See “The Class Timeout Value” on page 34.

Class Timeout (mins)

Another property in the .NET Properties tab is unique to the specific .NET service:

DescriptionProperty

The name of the method called by this service.Method Name

To change information about a .NET method

1. In the Navigation panel, double-click the service for which you want to change information
about its associated .NET method.

2. Click the .NET Properties tab to bring it to the front.

3. Perform one or more of the following actions:
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Perform the following...To do this...

In the Assembly Path field, type the new location of the directory
that holds the .NET assembly in which the method resides.

Change the assembly
path name

In theAssembly Namefield, type the newname of the .NET assembly
in which the method resides.

Change the assembly
name

In the Domain Name field, type the new domain name.Change the domain
name

In the Domain Configuration File field, type the name of the new
domain configuration file.

Change the domain
configuration file

4. On the File menu, click Save.

5. Stop and restart the CLR to clear the cache and make sure the correct assembly is loaded.

For more information, see “Starting and Stopping the Microsoft .NET CLR” on page 47.

You will see that these changes are applied to all .NET services that call methods in the same
assembly.

6. Go to Integration Server Administrator and reload the WmDotNet package.

Managing Domain Configuration File

TheDomainConfiguration File is typically used for any configurations associatedwith the domain,
that need to be accessed at the time of service invocation. For example, the information required
to access a database, or an input to the service, can be provided in the configuration file.

Youmust keep the domain configuration file in the same location as the assembly path. Also, enter
only the name of the file. The domain configuration file is tightly associated with the particular
domain. If youwant to run the same service under the same domainwith a different configuration
file, you must first destroy the domain to remove association with the earlier configuration file.
After destroying, recreate the domain, and associate another domain configuration file with the
domain.

Ensure that the configuration file has a key named as WhitelistDirectories and that the white-listed
directories are specified as value for the key. For more information on white-listed directories, see
“Specifying white-listed directories” on page 24.

Important:
Ensure that the configuration file exists before you create the application domain for the service.

Managing Class Lifetimes

.NET classes running on the CLR can maintain instance data, which are variables containing
information used acrossmultiple invocations ofmethods on the class. A class instance canmaintain
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instance data according to one of four Class Lifetime settings, described in the following table. All
.NET services associated with a class have the same lifetime. When you change the class lifetime
for a particular .NET service, Designer modifies the lifetimes of all services associated with the
same class.

InDesigner, you canmanage the class lifetime for a particular .NET service in the .NET Properties
tab for that service. The Class Lifetime property has the following valid settings:

DescriptionLifetime Setting

The webMethods Microsoft Package creates a single instance of
the class, or object, which has an unlimited lifetime. The class

Global

shares instance data among all sessions. Use this setting where
it is appropriate to gather data to be retrieved by multiple users.
You can create only one instance of a global object of a given type.

The webMethodsMicrosoft Package creates a separate object for
each user. The object exists until the user session is closed or until

Session

the object times out. The default is three minutes. See “The Class
Timeout Value” on page 34.

The webMethods Microsoft Package creates and destroys an
object each time a .NET service calls a method in the class. Data
may be kept during the lifetime of the object.

Single-Use

The .NET service calls amethod that does not require any session
data to be kept. All methods of the class are static and the
webMethods Microsoft Package does not create an object.

Static

Note:
If multiple services are using a given global object or a session object at the same time, those
objects need to be thread safe.

Use the Static lifetime setting only for static methods.

Modifying Class Lifetime
The following procedure describes how to modify the Class Lifetime setting for a .NET service.

To modify the Class Lifetime for a .NET service

1. In the Navigation panel, double-click the service for which you want to change the Class
Lifetime setting.

2. Click the .NET Properties tab to bring it to the front.

3. In the Class Lifetime list, select the setting to be used for this service.
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4. If you select the Session setting, determine if the current Class Timeout value is correct.

For more information, see “The Class Timeout Value” on page 34.

5. On the File menu, click Save.

The Class Timeout Value

The Class Timeout value applies only to .NET services having a Class Lifetime setting ofSession.
The clock starts when the webMethods Microsoft Package creates an instance of the class. The
clock is reset whenever a .NET service accesses the class. If time expires, the object is destroyed.
The default value is three minutes. Youmust choose a different value if you know that the default
timeout value would cause the object to be destroyed prematurely under normal usage.

To modify the Class Timeout value for a .NET service

1. In the Navigation panel, double-click the service for which you want to change the Class
Timeout setting.

2. Click the .NET Properties tab to bring it to the front.

3. In the Class Lifetime list, make sure the Session setting is selected.

4. In the Class Timeout field, type the correct timeout value, in minutes.

5. On the File menu, click Save.

Invoking a .NET Service from Designer

To test a .NET service using Designer as the client, you use the Run command on the Run menu.
Before you attempt to test .NET services, you should understand application domains and the
forms of data marshalling available for .NET services. For information on application domains,
see “Application Domains” on page 11.

Managing Application Domains
You can create and destroy application domains as explained below.

Using Services to Start and Destroy Application Domains

The first way is through the startDomain and destroyDomain services, which you can find in the
WmDotNet package in the Navigation panel of Designer:

WmDotNet/wm/dotnet/Runtime
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One advantage of using the startDomain service is that you can assign a .NET configuration file to
modify the behavior of the application domain.

Using Integration Server Administratorto Destroy Application Domains

At the time you run a .NET service in Designer, you can specify an application domain in which
to run it. If the application domain does not already exist, Integration Server creates it. This dynamic
creation featuremakes it easy to add application domains as you need them. Formore information,
see “Running a .NET Service in Designer ” on page 35.

Note:
If you do not specify an application domain, the service runs in the default webmDomain
application domain.

Using Integration Server Administrator, you can destroy an application domain on the Manage
Application Domain page. This method is easier than using the destroyDomain service because you
can find the application domain within a table and click the Destroy link.

For more information, see “The Manage Application Domains Page” on page 49.

Marshalling Data

Marshalling is the process of packing one or more items of data into a message buffer prior to
transmitting that message buffer over a communication channel.

If Integration Serverwere to call a .NETmethod and it returned an object, such as a SQL connection,
Integration Server could not process the object because it has meaning only within .NET. There
are two ways to marshall data across the division between Integration Server and .NET. The first
way is to use a reference ID, or an instance ID. Instead of bringing the object over, Integration
Server assigns an ID. If it is necessary tomake anothermethod call that uses that object as an input,
Integration Server uses the reference ID. If you want to keep using the same object, such as SQL
connection, you should use the reference ID. Note that the reference ID is valid only for the same
application domain.

The other way to marshall data is by passing XML. .NET has a built-in XML serializer that takes
that object, examines it, and turns it into an XML string. Integration Server can manipulate the
XML string and modify data, and then use that XML string as input to another method. If you
need to manipulate the object in Java in some way, use XML, but you should be aware of the
possible drawbacks. The use of XML is inefficient because you are passing a large string instead
of a single ID. Also you need to be careful in designing themanipulation of datawithin Integration
Server because the .NETXML serializermay create an invalid object upon its return. For information
on how to choose the marshalling type, see “Running a .NET Service in Designer ” on page 35
next in this chapter.

Running a .NET Service in Designer
To run a .NET service in Designer, do the following:
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To run a .NET service in Designer

1. In the Navigation panel, double-click the .NET service you want run.

2. Do one of the following:

In the Run menu, select Run As and click Run Service.

In the Designer toolbar, click the Run icon.

3. If there is an Input field, type a value to test the service.

4. In the domainName field, type the domain name of a new or existing application domain
name on Integration Server.

Note:
If you do not specify an application domain, the service runs in the default webmDomain
application domain.

5. In the marshallingType list, select one of the following:

Marshalling typeValue

Reference IDrefid

XML marshallingxml

6. Click OK.

Designer runs the .NET service on Integration Server and returns data as appropriate.
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What is webMethods Add-In for Microsoft Visual Studio?

Microsoft Visual Studio is a set of development tools for building a variety of applications. The
Visual Studio integrated development environment (IDE) supports several languages, including
Visual C# .NET and Visual Basic .NET.

With thewebMethodsAdd-In forMicrosoft Visual Studio, you can browse for and capture services
supported by an instance of webMethods Integration Server. You can then generate a client
assembly or a service provider assembly that invokes a particularwebMethods service. As needed,
you can also manually create webMethods client or server assemblies.

Using the Add-In for Visual Studio.

With thewebMethodsAdd-In forMicrosoft Visual Studio, you can introspect services on Integration
Server and use them to generate client code in the C# or Visual Basic language.

Opening the Add-in and Generating Code

To create a C# or Visual Basic file from a webMethods service

1. Open Visual Studio.

2. Open an existing .NET project or create a new one.

3. On the Tools menu, click webMethods Add-In for Microsoft Visual Studio.

If this menu item is not visible, make sure you have installed the add-in.

4. In the webMethods Add-In for Microsoft Visual Studio dialog box, provide the following
information about the instance of Integration Server to which you want to connect.

Type this...In this field...

The name and port number of Integration Server in the format
ServerName:PortNum. The default is localhost:5555.

webMethods Integration
Server

The name of a valid user account on this server.UserID

The password for the user account in UserID. Passwords are
case-sensitive.

Password

5. Click Connect. The webMethods Add-In for Microsoft Visual Studio window is displayed.
This window contains a tree view of packages and services on the Integration Server to which
you are connected.

Tip:
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The add-in opens as a floating window. You can dock the window by dragging it to the
Visual Studio toolbar.

6. Right-click a service and click Generate Code, and then click either of the following:

With this extension...To create code in...Click this...

.csC# .NETC# Code

.vbVisual Basic .NETVB.NET Code

The file takes the name of the service fromwhich it was generated and has an extension based
on the type of code generated.

Connecting to an Additional Integration Server
You can connect tomultiple Integration Servers from thewebMethodsAdd-In forMicrosoft Visual
Studio.

To connect to an additional Integration Server

1. WithwebMethods Add-In forMicrosoft Visual Studio displayed, right-click thewebMethods
Integration Server ’s node (or other nodes as well) and click Connect to Integration Server.

2. In the webMethods Add-In for Microsoft Visual Studio dialog box, provide the following
information about the instance of Integration Server to which you want to connect.

Type this...In this field...

The name and port number of Integration Server in the format
ServerName:PortNum.

webMethods
Integration Server

The name of a valid user account on this server.UserID

The password for the user account in UserID. Passwords are
case-sensitive.

Password

3. Click Connect.

Disconnecting from an Integration Server

To disconnect from an Integration Server

1. WithwebMethodsAdd-In forMicrosoft Visual Studiowindowdisplayed, right-click the node
for the Integration Server you want to disconnect.
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2. Click Disconnect from server_name .

The Integration Server is disconnected and the node is removed from the tree.

Using the Add-In for Visual Studio 2015 Onwards

With thewebMethodsAdd-In forMicrosoft Visual Studio, you can introspect services on Integration
Server and use them to generate client code in the C# or Visual Basic language.

Adding Integration Server and Generating Code

To create a C# or Visual Basic file from a webMethods service

1. Open Visual Studio.

2. Open an existing .NET project or create a new one.

3. On the Tools menu, click Invoke webMethods Extension.

If this menu item is not visible, make sure you have installed the add-in.

4. In the webMethods Extension template, click to add Integration Server. Provide the
following information about the instance of Integration Server to which you want to connect:

Type this...In this field...

The name and port number of Integration Server in the
format:ServerName:PortNum

Server Name

The name of a valid user account on Integration Server.Username

The password for the user account to connect to an Integration
Server. Passwords are case-sensitive.

Password

5. Click Add

6. Click to connect.

ThewebMethods Extensionwindow appears. This window contains a tree view of packages
and services on the Integration Server to which you are connected.

Note:
The Add-In opens as a floating window. You can dock the window by dragging it to the
Visual Studio toolbar.

7. Right-click any service and click Project Setting.
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8. Select a project from the Select Project drop-down box . Click Save.

9. Right-click the service and click Generate C# Code or Generate VB.NET Code.

File name is derived from the service that generates it, with a file extension depending on the
type of code that was generated.

Removing an Integration Server

You can remove an Integration Server by using webMethods Extension:

To remove an Integration Server

1. In webMethods Extension, select the Integration Server to be removed from the drop-down
box.

2. Click to remove.

Connecting to an Integration Server
You can connect tomultiple Integration Servers from thewebMethodsAdd-In forMicrosoft Visual
Studio.

To connect to an additional Integration Server

1. Click in webMethods Extension.

2. Click

The added Integration Servers can be found in the drop-down box.

Disconnecting an Integration Server

To disconnect an Integration Server

1. In webMethods Extension, select the Integration Server from the drop-down box.

2. Click

The Integration Server is disconnected.

webMethods Package for Microsoft .NET Installation and User’s Guide 9.0 41

5 Using the webMethods Add-In for Microsoft Visual Studio



Editing Integration Server details

To edit the Username and Password, click type the new Username and Password and then
select Update. However, the Server Name is not editable.

Refreshing an Integration Server

Click to refresh the Integration Server. This action collapses the tree view.
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Integration Server Administrator and webMethods Microsoft
Package

You can use Integration ServerAdministrator to administer andmanage thewebMethodsMicrosoft
Package from any standard browser. Among the activities you can perform are:

View general status of the webMethods Microsoft Package.

Start and stop the underlying .NET Common Language Runtime (CLR).

View status of (and destroy) application domains.

Unload .NET assembly dynamically-linked libraries (DLL) by destroying the application
domain that loaded them.

View runtime status and statistics about individual assembly DLLs.

View and manage .NET objects managed by the .NET CLR.

Install the webMethods Add-In for Microsoft Visual Studio.

Accessing the webMethods Microsoft Package

You can access the webMethods Microsoft Package through Integration Server Administrator.

To access the webMethods Microsoft Package from a connection to Integration Server

1. Point your browser to the host and port for an instance of Integration Server where the
webMethods Microsoft Package is installed. Use the syntax http://host:port. For example, if
Integration Server is running on the default port on a machine named myhost, you would
typehttp://myhost:5555.

2. Log on with a user name that has administrator privileges. For information on maintaining
administrator privileges, see webMethods Integration Server Administrator’s Guide.

3. In the Solutions menu of the navigation panel on the left side, click Microsoft Package.

Pages for Administering the Microsoft .NET Package

Integration Server Administrator contains a variety of pages for administering the webMethods
Microsoft Package, depending on the menu item selected in the navigation panel. The pages in
Integration Server Administrator are described in the following places:

DescriptionPage

Starts and stops the Microsoft .NET CLR, and displays information and
statistics. See “The Manage CLR Page” on page 46.

Manage CLR
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DescriptionPage

Displays information about the application domains loaded onto the
Microsoft .NET CLR. See “The Manage Application Domains Page” on
page 49.

Manage Application
Domains

Controlsmonitoring options for thewebMethodsMicrosoft Package. See
“The Manage Monitoring Options Page” on page 52.

Manage Monitoring
Options

Makes available some installation packages needed by users of the
webMethods Microsoft Package. See “The Install VS Plugin Page” on
page 53.

Install VS Plugin

Displays information about the assemblies loaded onto a specific
application domain. See “The View Assemblies Page” on page 50.

View Assemblies

Displays information about object instances created and currently running
in a specific application domain. See “TheManage .NETObject Instances
Page” on page 51.

Manage .NET Object
Instances

Displaying Pages in Integration Server Administrator

To display pages for the webMethods Microsoft Package

1. Open Integration Server Administrator and display thewebMethodsMicrosoft Package pages,
as described in “Accessing the webMethods Microsoft Package ” on page 44.

2. In the Administration menu of the navigation panel, click the link to the page you want to
display.

The exceptions to this step are:

Install VS Plugin page, available in the Resources menu of the navigation panel.

View Assemblies page, available on the Manage Application Domains page.

Manage .NETObject Instance page, available on theManage Application Domains page.

Refreshing the View
Integration Server Administrator polls Integration Server at regular intervals for information about
the Microsoft .NET CLR. In addition to automatic polling, you can poll at any time using the
Refresh command.

To refresh the information in Integration Server Administrator

1. Make sure Integration Server Administrator is displaying one of the pages you can select from
the navigation frame.
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2. Click Refresh, commonly found in the upper-left portion of the page.

To change the interval for automatic polling, see “The Manage Monitoring Options Page” on
page 52.

The Manage CLR Page

Using the Manage CLR page, you can start and stop the Microsoft .NET CLR and display
information about it. This page has the following topics:

“Values in the Manage CLR Page” on page 46.

“Starting and Stopping the Microsoft .NET CLR” on page 47.

“Tracing for the webMethods Microsoft Package ” on page 48.

To display theManageCLRpage, open Integration ServerAdministrator as described in “Accessing
the webMethodsMicrosoft Package ” on page 44 and, in the Administration menu, click Manage
CLR.

Values in the Manage CLR Page

The CLR Info panel contains the following values:

DescriptionValue

Current state of the .NET CLR. Values are:Status

Loaded-The CLR is running.

Not Loaded-The CLR is not running.

The version number of the CLR (Microsoft .NET Framework).Version

If the CLR is running (Loaded), contains the date and time the CLR was
started.

Start Time

The CLR Statistics panel contains the following values:

DescriptionValue

The total number of methods invoked since the CLR was started.Method Invoke Count

The number of application domains loaded onto the CLR.Application Domain
Count

The number of operating system threads being used by the CLR.Physical Thread
Count
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DescriptionValue

The number of logical threads as allocated within the CLR. This number
is typically larger than the Physical Thread Count, but an excessive

Logical Thread Count

difference, several times the physical count, indicates an error. In case of
error, you must restart the CLR.

The amount of memory in use by webMethods Microsoft Package.Total Process Memory
Used

The amount of memory in use by the CLR.CLR Memory Used

An action you can use to enable or disable tracing (see “Tracing for the
webMethods Microsoft Package ” on page 48). Tracing is disabled by
default.

Tracing

Tracing is currently enabled. Click to disable.Enabled

Tracing is currently disabled. Click to enable.Disabled

Starting and Stopping the Microsoft .NET CLR
You can start and stop the Microsoft .NET CLR in the Manage CLR page of the webMethods
Microsoft Package.

To start or stop the .NET CLR

1. Open Integration Server Administrator and display thewebMethodsMicrosoft Package pages,
as described in “Accessing the webMethods Microsoft Package ” on page 44.

2. In the Administration menu of the navigation frame, click Manage CLR.

3. In the Manage CLR page, determine the current status of the CLR by looking at the Status
field of the CLR Info panel:

The CLR is...If the status is...

Not running.Not Loaded

Running.Loaded

4. Perform one of the following actions:

Click this link...To do this...

Start the CLR.Start the CLR
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Click this link...To do this...

Stop the CLR.Stop the CLR

Tracing for the webMethods Microsoft Package
The webMethodsMicrosoft Package provides two kinds of tracing for services created from .NET
assembly methods:

.NET assembly method invocation tracing.

.NET assembly introspection tracing.

See “Location of the Log File” on page 49.

Method Invocation Tracing

Method invocation tracing writes trace statements at all points: IData decode, assembly load,
module location, class location,method location, parameter conversion, returnparameter conversion
and IData modifications. You can set method invocation tracing for individual .NET services, or
for all .NET services.

You can setmethod invocation tracing for individual services created from .NET assemblymethods.
This type of tracing is useful if you want to collect information on a specific service.

To set method invocation tracing for an individual service

1. From the navigation panel in Designer, double-click the .NET service for which you want to
enable method invocation tracing.

2. On the Run menu, click Run.

3. In the Trace field of the input dialog box, type true.

Tracing is enabled for this service every time it is run until you clear the Trace field or replace
truewith false.

Using the webMethods Microsoft Package, you can enable method invocation tracing for all
services created from .NET assembly methods, overriding any services for which the trace input
parameter is set to false. To enable or disable all tracing, see “Controlling Tracing from Integration
Server Administrator ” on page 49.

Assembly Introspection Tracing

Assembly introspection tracing writes trace statements at all introspection points: assembly load,
module discovery, class discovery, method discovery, parameter discovery, and XML document
generation. You can set introspection tracing only in the Integration Server Administrator. To
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enable or disable all tracing, see “Controlling Tracing from Integration Server Administrator ” on
page 49.

Location of the Log File

The log file for all tracing performed by the webMethods Microsoft Package is
Integration Server_directory \logs\MicrosoftPackage-domain_name.log. If the domain name is not
provided while executing the service, the Tracing log is created in the default log file
Integration Server_directory \logs\MicrosoftPackage-webmDomain.log.

Note:
When tracing is enabled, the webMethods Microsoft Package creates a large number of log
messages for each service, resulting in slower processing and the consumption of large amounts
of disk space. Software AG recommends that you must enable the tracing only when you want
to troubleshoot the webMethods Microsoft Package.

All internal system logs for webMethods Microsoft Package are logged to
Integration Server_directory \logs\MicrosoftPackage-wmSystem.log

Controlling Tracing from Integration Server Administrator

Use the Integration Server Administrator to enable or disable tracing for assembly introspection
and for all services invoked from .NET assembly methods. To set method invocation tracing for
individual services, see “Method Invocation Tracing” on page 48.

To enable tracing for all services created from .NET assembly methods

1. Open Integration Server Administrator and display thewebMethodsMicrosoft Package pages,
as described in “Accessing the webMethods Microsoft Package ” on page 44.

2. In the Administration menu of the navigation frame, click Manage CLR.

3. In the Manage CLR page, determine the current status of tracing by looking at the Tracing
action of the CLR Statistics panel.

4. Perform one of the following actions:

Click this link...To do this...

DisabledEnable tracing

EnabledDisable tracing

The Manage Application Domains Page

An application domain is a boundary between objects in the same application scope, which is
established by the CLR. Application domains provide the ability to isolate multiple applications
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running within a process. You can have multiple application domains loaded onto the CLR and
destroy each of them independently without stopping and restarting Integration Server.

To display the Manage Application Domains page, open Integration Server Administrator as
described in “Accessing the webMethods Microsoft Package ” on page 44 and, in the
Administration menu, click Manage Application Domains.

The Manage Application Domains page displays the following information about the application
domains loaded into the Microsoft .NET CLR.

DescriptionValue or link

The name of the application domain.Domain Name

A link to the ViewAssemblies page for the application domain. See “The
View Assemblies Page” on page 50.

View Assemblies

A link to the Manage .NET Object Instances page for the application
domain. See “The Manage .NET Object Instances Page” on page 51.

View Objects

Information regarding the application domain such as Name, Started
Time, Number of invoked methods and Last method invoke time.

View Details

The number of timesmethods in the assembly have been invoked for the
application domain.

Method Invoke Count

An action you can use to destroy the application domain. Click Destroy.Action

Note:
You cannot destroy thedefault applicationdomainnamedwebmDomain.

The View Assemblies Page

To view the assemblies in an application domain

1. Open Integration Server Administrator and display thewebMethodsMicrosoft Package pages,
as described in “Accessing the webMethods Microsoft Package ” on page 44.

2. In the Administration menu of the navigation panel, click Manage Application Domains.

3. In the View Assemblies column for the application domain, click Assemblies.

The View Assemblies page displays the following information about the assemblies loaded into
the Microsoft .NET CLR.

DescriptionValue

The name of the assembly.Assembly Name
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DescriptionValue

The version number of the assembly, if applicable.Version

The locale of the assembly. A value of neutral means the assembly has
not been localized.

Culture

The number of timesmethods in the assembly have been invoked for the
application domain.

Method Invoke Count

The most recent date and time a method in the assembly was invoked.Last Invoke Time

The Manage .NET Object Instances Page

To view the .NET objects in an application domain

1. Open Integration Server Administrator and display thewebMethodsMicrosoft Package pages,
as described in “Accessing the webMethods Microsoft Package ” on page 44.

2. In the Administration menu of the navigation frame, click Manage Application Domains.

3. In the View Objects column for the application domain, click Objects.

An object is an instance of a class. Objects have the ability to contain data, making it possible to
store data. An object with a Session lifetime allows a user session to store data needed by a later
method; an object with a Global lifetimemakes it possible for multiple user sessions to share data.
The Manage .NET Object Instances page displays the following information about objects with a
Session or Global lifetime currently running on the Microsoft .NET CLR.

DescriptionValue

An action you can use to destroy an object. Click Destroy.Action

The class to which the object belongs.Object Class

The unique value that identifies this particular instance.ID

The number of methods that have been invoked on this object since it
was created.

Invoke Count

The time to live (TTL) for this object and the timeout value established
for it, both in seconds. When the TTL value equals zero, the object is
destroyed. Applicable to only the Session lifetime.

TTL/Timeout (sec)

The average response time, in milliseconds, of all methods invoked on
the object since the object was created.

Avg Response (ms)

The name of the method most recently invoked on the method.Last Method
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DescriptionValue

The response time, inmilliseconds, of themethodmost recently invoked
on the object.

Last Method
Response (ms)

The Domain Details Page

To view the details of an application domain

1. Open Integration Server Administrator and display thewebMethodsMicrosoft Package pages,
as described in “Accessing the webMethods Microsoft Package ” on page 44.

2. In the Administration menu of the navigation frame, click Manage Application Domains.

3. In the View Details column for the application domain, click Details.

The Domain Details page displays the following information about the application domain.

DescriptionValue

The name of the application domain.Name

The time when the application domain started.Start Time

The number of times methods in the application domain have been
invoked since the CLR started.

Method Invoke Count

The most recent date and time a method in the application domain was
invoked.

Last Invoke Time

The Manage Monitoring Options Page

Use the Manage Monitoring Options page to change the refresh interval, which determines how
often Integration Server Administrator polls Integration Server for information about the
webMethods Microsoft Package.

To change the refresh interval

1. Open Integration Server Administrator and display thewebMethodsMicrosoft Package pages,
as described in “Accessing the webMethods Microsoft Package ” on page 44.

2. In the Administration menu of the navigation frame, click Manage Monitoring Options.

3. In the Refresh Interval field of the Options page, type a value for the polling interval, in
seconds.
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4. Click Save Changes.

The change in polling interval takes place immediately.

The Install VS Plugin Page

Use the Install VS Plugin page to access the webMethods add-in for Microsoft Visual Studio.

To install the webMethods add-in for Microsoft Visual Studio

1. Open Integration Server Administrator on a machine where Visual Studio is installed.

2. In the Resources menu of the navigation panel, click Install VS Plugin.

3. Right-click the required Install File depending on the version of the Visual Studio IDE and,
in the pop-up menu, click Save Link As or Save Target As, depending on your browser, to
save a copy on your machine.

Note:
Make sure the file extension is .msi for Microsoft Visual Studio 2012 and lower before you
save the file to your machine.

Make sure the file extension is .vsix for Microsoft Visual Studio 2015 and higher before
you save the file to your machine.

4. Run the executable file and follow the instructions “Using thewebMethodsAdd-In forMicrosoft
Visual Studio ” on page 37.
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Overview

This chapter describes the set of trouble shooting instructions, and the list of error codes and
supporting information in the webMethods Microsoft Package.

Trouble Shooting

If you are facing connectivity issues with the webMethods Microsoft Package Windows Service,
try the following steps to resolve the issue:

1. Check if the webMethods Microsoft Package Windows Service is running.

2. Check if the webMethodsMicrosoft PackageWindows Service is running on the correct HTTP
port. Verify that the port number specified in properties.cnf file in Integration Server_directory
\packages\WmDotNet\config directory is same as the port number specified in the
wmSystem.exe.config file in Software AG_directory /DotNetHost directory. For information on
modifying the HTTP port, see “Modifying HTTP port” on page 25.

3. Check if the CLR is loaded. For information on Managing the CLR, see “The Manage CLR
Page” on page 46.

webMethods Microsoft Package Error Codes

DescriptionName

.NET CLR is not running. Start the .NET CLR to access the service.MIP.1003.0003E

Explanation: Access to the service failed as the .NET CLR is not started
before accessing the service of the WmDotNet package.

Action: Start the .NET CLR from the Microsoft Package Administration
page on the Integration Server Administrator.

Insufficient input parameters.MIP.1004.0004E

Explanation: All the mandatory input values are not passed as input to the
service.

Action: Verify that all mandatory input parameters are passed as input to
the service.

Specify valid Application Domain name.MIP.1005.0005E

Explanation: Valid name is not specified for the Application Domain.

Action: Enter a valid name for the Application Domain.

Unable to access the assembly.MIP.1007.1007E

Explanation: The assembly path of the method is not part of the
whitelist-directories.
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DescriptionName

Action: Verify the domain configuration file associated with the executing
assembly and make sure that the assembly path is part of whitelist entries.
After adding the entry, restart the "webMethods Package forMicrosoft .NET"
windows service.

Unable to browse the File System.MIP.1201.0009E

Explanation: The location specified does not exist.

Action: Verify that the specified location exists.

No directories are configured to allow access.MIP.1202.0010E

Explanation: There are no validwhite-list directories specified in the domain
configuration file.

Action: Make sure that valid directory names are added to the domain
configuration file.

Unable to find valid directories/files in the path specified.MIP.1203.0011E

Explanation: An invalid location is specified for the assembly.

Action: Make sure that a valid path is specified, and that the target assembly
exists in the specified path.

Invalid assembly path.MIP.1302.0014E

Explanation: An invalid path is specified for invoking the method of an
assembly.

Action: Verify the specified assembly path and invoke the method again.

Invalid assembly name.MIP.1303.0015E

Explanation: An invalid assembly name is specified for invoking themethod
of an assembly.

Action: Verify the assembly name and invoke the method again.

Invalid assembly path/name.MIP.1304.0016E

Explanation: An invalid assembly path/name is specified for invoking the
method of an assembly.

Action: Verify the specified assembly path/name and invoke the method
again.

Unable to access the location of the service.MIP.1305.0017E
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DescriptionName

Explanation: The services being invoked were created in earlier versions of
webMethods Package for Microsoft .NET, and a network share is specified
as the location of the service. This is not supported in the current version.

Action: Verify that the assembly path refers to a valid UNC shared location,
and that the webMethods Package for Microsoft .NET windows service is
executed under the same user account.

Invalid file format.MIP.1309.0021E

Explanation: This error occurredwhile migrating the .NET services created
in earlier versions, to webMethods Package for Microsoft .NET 9.0 version.

Action: Verify that all the assembly extensions are either .exe or .dll.

Unable to load the assembly.MIP.1310.0022E

Explanation: This can happen when the specified assembly failed to load
under the given Application Domain.

Action: Make sure that assembly path is accessiblewithout any security/lock
restrictions.

Unable to invoke the method in the specified assembly.MIP.1401.0024E

Explanation: This can happen if the invocation of specified method fails.

Action: Chek the DetailErrorID/DetailErrorMessage for more details.

Unable to convert the specified input parameter.MIP.1404.0027E

Explanation: Invalid value(s) are passed as input arguments to themethod.

Action: Verify that only valid arguments are passed as input to the method.

Insufficient parameters to invoke the service.MIP.1405.0028E

Explanation: All the required input parameters are not passed while
invoking the service.

Action: Verify that all required input parameters are passed and invoke the
service again.

Unable to convert the specified input parameter to array.MIP.1406.0029E

Explanation: Invalid format specified for the input to be converted to array
.

Action: Verify that a valid array format is specified for the input.

Invalid target array dimension specified. Maximum array dimension
supported is 2.

MIP.1407.0030E
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DescriptionName

Explanation: This error occurs when the target method expects an array of
size 2-dimensional or greater than 2-dimensional. The maximum array size
supported by webMethods Package for Microsoft .NET is 2-Dimensional.

Action: Verify that the target array specified is of size 2-dimensional, or less
than 2-dimensional.

Invalid source array dimension specified. Maximum array dimension
supported is 2.

MIP.1408.0031E

Explanation: This error occurs when the source method expects an array of
size 2-dimensional or greater than 2-dimensional. The maximum array size
supported by webMethods Package for Microsoft .NET is 2-Dimensional.

Action: Verify that the source array specified is of size 2-dimensional, or
less than 2-dimensional.

Dimension mismatch between source and target arrays.MIP.1409.0032E

Explanation: This error occurs when the dimension of array expected by
the target method is different from the dimension of the array passed to the
target method.

Action: Verify that the dimension of array passed to the target method is
as expected by the target method.

Unable to unmarshall the input parameter.MIP.1410.0033E

Explanation: This error occurs when valid XML/Instance ID details and
suitable marshalling type parameter are not specified.

Action: Verify that valid XML/Instance ID details and suitable marshalling
type parameter are specified.

Unable to deserialize the XML input parameter to an object.MIP.1411.0034E

Explanation: Incompatible XML structure, not relevant to the class structure
is passed as input .

Action: Verify that a compatible XML structure revelant to the class structure
is passed as input.

Unable to serialize the output parameter object to XML format.MIP.1412.0035E

Explanation: The marshalling type passed for the method invocation is
XML, but the output parameter object is not XML serializable.

Action: Verify that the parameter object is XML Serializable. If the object is
not XML Serializable, set the marshalling type as refid.

Unable to marshall the output parameter.MIP.1413.0036E
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DescriptionName

Explanation: Invalid marshalling type parameter is specified.

Action: Verify that a valid marshalling type parameter of xml/refid is
specified.

Unable to convert the output parameter to array.MIP.1414.0037E

Explanation: Invalid array-size returned by the method.

Action: Verify that the method returns array of maximum 2-dimensional
size.

Unable to invoke the method/operty in the specified assembly.MIP.1416.0039E

Explanation: This error occurswhen valid input parameters are not provided
to invoke the method/operty.

Action: Verify that valid input parameters are specified and invoke the
method/operty again.

Specifed instance ID is no longer valid.MIP.1420.0043E

Explanation: This error occurred as the specified instance ID is no longer
valid.

Action: If Class Lifetime set as Session, with Class Timeout set as small
value, increase the Class Timeout value. Alternately, to set infinite lifetime
for instance ID, set Class Lifetime as Global.

Unable to invoke the constructor in the specified assembly.MIP.1421.0044E

Explanation: Invalid input parameters specified for invoking the
constructior.

Action: Specify valid input parameters and invoke the constructor again.

Unable to invoke the field in the specified assembly.MIP.1423.0046E

Explanation: Invalid value specified for the public field in the assembly.

Action: Verify that valid value is specified for the field.

Public field cannot be empty. Specify valid value.MIP.1424.0047E

Explanation: No value is provided for the public field in the assembly.

Action: Specify a valid value for the public field in the assembly.

Unable to process the input field value.MIP.1426.0049E

Explanation: Invalid value specified for the field.

Action: Specify valid value for the field.
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DescriptionName

Invalid instance ID.MIP.1429.0052E

Explanation: Invalid instance ID passed to invoke the service.

Action: Specify valid instance ID to invoke the service. Do not specify an
instance IDwhen invoking a service under Static/Single-Use lifetime setting.

Unable to retrieve the required CLR runtime information.MIP.100.0083E

Explanation: The service cannot fetch the CLR runtime information.

Action: Verify that the webMethods Package for Microsoft .NET service is
started and try to retieve the CLR runtime information.

Unable to start/stop the CLR.MIP.103.0089E

Explanation: An unspecified error occurred while trying to start/stop the
CLR.

Action: If error occurred when trying to start the CLR, verify that the CLR
is not already running. If error occurred when trying to stop the CLR, verify
that the CLR is not already stopped.

Unable to start the CLR.MIP.104.0090E

Explanation: An unspecified error occurred while trying to start the CLR.

Action: Verify that the CLR is not already started.

Unable to stop the CLR.MIP.105.0091E

Explanation: An unspecified error occurred while trying to start the CLR.

Action: Verify that the CLR is not already started.

Unable to access the properties file. Reason: {0}.MIP.402.0121E

Explanation: The properties.cnf file does not exist.

Action: Verify that properties.cnf file is created at the time of installation.
For more information, see the webMethods Package for Microsoft .NET
Install and User's Guide.

webMethods Package for Microsoft .NET Installation and User’s Guide 9.0 61

A Errors and Exception Handling



62 webMethods Package for Microsoft .NET Installation and User’s Guide 9.0

A Errors and Exception Handling



B Glossary

application domain
Aboundary between objects in the same application scope,which is established by the Common
Language Runtime. Application domains provide the ability to isolate multiple applications
running within a process.

assembly
A component designed to operate within the Microsoft .NET environment. Assemblies are of
two types, DLLs (dynamically-linked library) and executables.

CIL
Common Intermediate Language. See MSIL.

CLR
Common Language Runtime. The execution engine for .NET Framework applications.

COM
Component ObjectModule. Defines how object linking and embedding (OLE) objects and their
clients interact within processes or across process boundaries.

CTS
Microsoft Common Type Specification. A comprehensive specification for a
language-independent object-oriented data type system that is capable of representing simple
data types, such as integers, or more complex data types that are embodied as classes.

DLL
Dynamically-linked library. A library that is linked to an application at run time, rather than
during compilation. A DLL is a module that contains functions and data.

Framework
See Microsoft .NET Framework.

IDE
Integrated development environment. A system for software development, typically including
a syntax-directed editor and integrated support for compiling the program and relating errors
back to the source code.

IL
Intermediate Language. See MSIL.

JVM
Java Virtual Machine. Compiles Java into machine-independent object code, or bytecode.
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managed code
Code executed and managed by the CLR.

Microsoft .NET Framework
The programming model of the .NET platform for building and running XMLWeb services
and applications.

MSIL
Microsoft Intermediate Language. A high-level object-oriented language that is similar to Java
bytecode. The Microsoft .NET environment compiles source code into MSIL. At run time, the
CLR compiles MSIL into machine code.

TLBIMP
Type Library Importer. Provides interoperability with existing COM components.

UNC
Uniform (or Universal) Naming Convention. A convention for specifying directories, servers,
and other resources on a network.

Unmanaged code
Code that is executed outside the CLR.

Visual Studio .NET
Visual Studio .NET is a set of development tools for building a variety of applications. The
Visual Studio IDE supports several languages, including Visual C# .NET.
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